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Rozmiestnenia prvkov na čipe- IC Station 

Rozmiestnenie prvkov na čipe (Layout), alebo morfológia masiek pre výrobu 

integrovaných obvodov je časovo náročnejšie ako nakreslenie v DA. 

 

Je zložitejšie a vyžaduje si presnosť pri vytváraní jednotlivých vrstiev! 

 

Pri rozmiestnení prvkov je potrebné voliť vodivé vrstvy tak, aby výsledný návrh 

nemal: 

impedančný, 

alebo kapacitný charakter. 

  



Do prostredia Layout sa dostaneme tak, že na začiatku si vytvoríme v knižnici, 

v okne View, nový New View Type → LAYOUT 

 

  

 

Vytvorenie projektu Layout  



V okne Create New View zvolíme Type Layout → Finish 

Nasledovne sa nám otvorí prostredie v ktorom môžeme navrhnúť 

rozmiestnenie prvkov na čipe a ich prepojenie- Layout. 

 

 

 

 

 

 

 

 

 

Vytvorenie View Type  



Odporúčanie- tabuľku nástrojov → IC Palletes presunúť do ľavej lišty. 

Stlačíme ľavé tlačidlo na myške, držíme na IC Palettes a presunieme do 

ľavej lišty. Presun lišty IC Palettes 

 



ODPORÚČANIE zapnúť Hotkeys! 

Vpravo hore nad Layer Pallete           

Zapnutie Hotkeys:               

 

 

 

 

 

Hotkeys umožňuje klávesové skratky 

R (rotácia), C (kopírovanie), M (premiestňovanie).  

Po zadaní skratky R, M, či C     

možné definovať smer (Direction)- horizontálne, vertikálne, diagonálne. 

Výrazne to uľahčuje rozloženie prvkov.  



Výber prvkov 

Jednotlivé prvky si vyberieme z hornej „hlavnej“ lišty 

HIT-Kit Utilities → AMS Devices (obr.). 

Po usadení jednotlivých prvkov 

prvky od značíme klávesovou skratkou F2. 

 

AMS Devices 



Vloženie tranzistorov 

Tranzistory NPN → nastavenia parametrov. 

Dĺžka emitora podľa požiadaviek, napr. 12 alebo 3 (Emitter length). 

Connectivity (obr.) odporúčané odškrtnúť všetky tri políčka. V NPN 

Tranzistor Types vyberieme požadovaný druh tranzistora → OK 

      

Nastavenie parametrov NPN tranzistora  



Vloženie tranzistorov 

Názorná ukážka tranzistora typu NPN 232 je na obr. 

Posúvanie tranzistora pomocou kurzorov je prehľadnejšie. 

Je možné použitie aj klávesové skratky Hotkeys. 

 

NPN 232  



Vloženie rezistorov 

Rezistory vyberieme z HIT-Kit Utilities → AMS Devices→RES. 

Po ich zvolení sa zobrazí okno Resistor Parameters. 

Odpor rezistora môžeme zadať: 

priamo hodnotou 

zvolením dĺžky a šírky (Length, Width) odporovej vrstvy rezistora. 

V položke Number of bends zadáme nulu. 

Vyberieme požadovaný typ rezistora. 

Uhol rohov rezistora odporúčam na Ninety Deg. Corners (Fourty five Deg. 

Corners). 

Ostatné zvolíme na No Guard Ring a No Dummy Resistors → OK  



Vloženie rezistorov 

Na obr. je príklad ako zadávať jednotlivé parametre rezistora a príklad 

rezistora rpoly2_nsub v prostredí. 

 

 

Nastavenie parametrov rezistora   rpoly2_nsub 



Vytvorenie vodivých ciest 

Prepájanie prvkov medzi sebou môžeme riešiť výberom z ponuky 

Easy Edit →  Shape 

Path (obr.) 

ODPORÚČANIE Shape ľahšia modifikácia ciest 

Je dôležité, na ktorej vrstve ťaháme vodivé cesty → vpravo v lište 

Veľkosť cesty volíme optimálne 

Každá vrstva má iné vodivé vlastnosti, preto je potrebné poznať parametre 

jednotlivých vrstiev 

Možnosť Context→Hierarchy →ping zobrazí všetky vrstvy 

alebo Ctrl+F6  



Vytvorenie vodivých ciest 

Ruler pomocné pravítko umožňuje určiť počiatočný bod od merania až po 

koncový bod. 

Ctrl+F6 

 

Vytváranie ciest 



Vytvorenie vodivých ciest 

Pri navrhovaní Layout vyžívame viacero vrstiev 

AMS technológia ponúka na realizáciu až štyri vrstvy 

Medzi každú vrstvu je potrebné vytvoriť medzivrstvu 

Add objects→ Via → a následný výber medzivrstvy (m1m2, m2m3, m3m4). 

m1m2 na prepojenie vrstiev MET1 a vrstvy MET2. 

 

Vytváranie medzivrstiev  



Vytvorenie vodivých ciest 

Často dochádza k nedodržaniu minimálnych vzdialeností, napr. pri vkladaní 

medzivrstvy na emitor. Tranzistor musí mať pevne danú medzeru medzi 

emitorom a bázou. 

Pri vkladaní medzivrstvy sa vytvára napr. MET1 a MET2 vrstva, je potrebné 

počítať s tým, že sa priestor medzi jednotlivými časťami zúži. 

.  

Korekcia medzivrstiev  



Vytvorenie vodivých ciest 

Vľavo je zobrazený potrebný priestor medzi emitorom a bázou. 

V strede je tento priestor zúžený vrstvou MET1, ktorá vznikla pri vkladaní 

medzivrstvy m1m2. 

Vpravo je medzivrstva, ktorá si drží odstup medzi bázou a emitorom 

.  

Korekcia medzivrstiev  



Spustenie DRC 

Kontrola návrhu Calibre→Run DRC v  hlavnej hornej lište. 

V okne Calibre na ľavej strane sú uvedené všetky chyby návrhu. 

Zvýraznenie chýb v návrhu: pomocou funkcie Highlight, 

alebo klávesová skratka H pre označenú chybu v okne, kde sú uvedené 

chyby-je ľahšie prísť na príčinu chyby. 

Odstránenie zvýrazneného 

„lemovania“ chýb realizujeme 

pomocou tlačidla F4 v okne zoznamu 

chýb. 

Takto sa skontroluje celý návrh. 

Run DRC 

Zvýraznenie chýb 



Odstraňovanie chýb Run DRC 

Uvedieme niektoré základné chyby a tipy na ich odstránenie. 

Po výbere Calibre → Run DRC v ľavej lište je uvedené: počet chýb. 

Po výbere chyby zo zoznamu sa vypíše komentár v dolnej lište. 

Toto okno sa po odstránení neaktualizuje. 

Po oprave 

chyby: 

nanovo 

spustiť 

Run DRC  

 

Zoznam 

chýb 



Chyba , nám už z názvu napovedá, že vrstva FIMP 

chýba alebo ju máme zle usadenú. Cez funkciu Highlight si túto chybu 

vyznačíme (graficky znázornené na obr.). Na prvý pohľad sa zdá, že je to 

v poriadku, pri bližšom priblížení zistíme, že vrstva je jemne posunutá. Túto 

chybu odstránime tak, že 

dáme vrstvu na zvýraznené 

miesto. 

Označíme vrstvu FIMP 

a  držaním CTRL dáme 

vrstvu na správne miesto. 

Podobne je to aj s vrstvami 

NLDD, HBT, či NBUR. 

Chyba pri vkladaní vrstvy 

FIMP 



 

 upozorňuje na to, že v schéme sa 

nachádza objekt, ktorý nie je zapojený. Je to častou chybou pri nedôslednom 

kopírovaní. 

 

 poukazuje na šírku vodivej cesty MET1, ktorá 

nie je zakončená na prislúchajúci kolektor tranzistora. Z komentára 

nachádzajúceho sa v dolnej lište (MINIMUM MET1 width 0.5) je jasné, že 

šírku tejto cesty nie je možné zhotoviť technológiou, pretože jej šírka je 

nedostatočná. 

  



Vyznačený, vyčnievajúci trojuholník vodivej vrstvy umiestnime tak, aby bol 

zarovno s hranou kolektora 

(obr.)! 

 

„Prečnievajúci“ dodatok 

vodivej vrstvy 

 

Chyba je príčinou toho, že sme si v návrhu 

zamenili rezistor s iným substrátom. 

Odstránenie chyby: rpoly2_nsub, zameníme za 

rpoly2_psub! 

Chyba pri zámena substrátov 



 

Nedostatočná medzera medzi rozmiestnením prvkov (Minimum BNTUB 

spacing = 4.0). 

 

Môže sa tiež vyskytnúť podobná chyba, ale týkajúca sa nedostatočným 

priestorom medzi rovnakými vodivými cestami. 

 

Je potrebné jeden z tranzistorov 

posunúť minimálne na úroveň 

vyznačenej čiary tak, ako je 

zobrazené na obr. 

 

Nedostatočný priestor medzi prvkami 

  



Vytvorenie portov 

Označíme vodivú cestu, ktorá má slúžiť ako vstupný alebo výstupný port. 

Port si pomenujeme: pravým klikom klikneme na označenú vodivú vrstvu 

a vyberieme Add → Text. V okne zadáme Text value (požadovaný názov 

portu), typ vodivej vrstvy ak je to MET1, tak zvolíme M1PIN ! 

 

Ak sme nastavili hodnoty ako na obr. následne 

klikneme na vodivú cestu, ktorá má byť portom. 

Snažíme sa, aby marker portu bol vložený 

do stredu vodivej cesty, tak ako na obr. vpravo! 

 

Vytváranie portov 

  



Po označení tej istej vodivej cesty/ portu, pokračujeme ďalej: pravým 

kliknutím vyberieme Add → Make → Port. 

Definujeme ďalšie vlastnosti portu: typ portu (Port Type) smer v akom bude 

port pracovať (Direction). 

Pre VEE a GND volíme typ Power a smer In. 

 

Pre vstupné porty (Direction In) typ 

Signal. 

Pre výstupné porty (Out) sú v smere 

Out. 

Ukážka menu nastavenia portov je 

zobrazená na obr. 

Menu pri vytváraní portov 

  



Pre bipolárne tranzistory je potrebné všetky substráty pripojiť na 

najzápornejší potenciál/ k zdroju VEE=-3V 

Teda vrstvu pdm1, ktorú nájdeme v Easy edit → Via → Shape via → pdm1 

obr. 

 

 

 

 

 

Medzivrstva pdm1 pripojená na port VEE 

  



Overenie- Run LVS 

Porovnanie obvodu v simulačnom prostredí s návrhom rozmiestnenia 

prvkov na čipe (s layout-om). 

Otvorenie obvodu v simulačnom 

prostredí, odstránenie všetkých 

zdrojov! 

Spustíme simuláciu a v pravej lište 

klikneme na Session → Netlister. 

V Setup SPICE Netlister nastavíme 

parametre tak, ako je to ilustrované 

na obr. 

 

Setup SPICE Netlister 



V simulačnom prostredí obvodu vyberieme z hornej lišty HIT-Kit Utilities → 

Eldo 2 Calibre. 

Zobrazí sa okno (obr.), v ktorom zadáme: 

Cesta Eldo Netlist napr.: 

$Priezvisko/default.group/logic.views/zadanie/vpt_s35d4_device_ams/zadanie_vpt_

s35d4_device_ams.spi 

Cesta Calibre Netlist napr.: 

$Priezvisko/default.group/logic.views/zadanie/vpt_s35d4_device_ams/zadanie.calibr

e 

 

 

 

Eldo 2 Calibre 



Po zadaní ciest sa vrátime spať do prostredia Layout. 

Zvolíme funkciu Layout Vs Schematic, v hornej lište Calibre → Run LVS. 

Zobrazí sa okno Calibre Interactive, kde je potrebné zadať cestu pre Inputs 

v sekcii Netlist. Cesta môže vyzerať napr.: 

/home/Priezvisko/ams_circuits.proj/BP.lib/default.group/logic.views/zadanie/v

pt_s35d4_device_ams/zadanie.calibre 

Dôležitou súčasťou je odškrtnúť políčko Export from schematic viewer (obr.).  

 

 

Je možné využiť 

aj Start RVE, 

priamo poukáže 

na chybu. 

  



V okne Layout Cell/Type je možné vidieť nedostatky. Po kliknutí na problém/ 

nedostatok sa nám v Layout-e zvýraznia chyby, ktoré nie sú v súhlasné 

s navrhnutým obvodom. 

 

Je potrebné skontrolovať 

počet Ports, Nets, 

Instances navrhnutého 

obvodu a Layout-u. 

 

Príklad okna Calibre- 

RVE je na obr. 

 

Calibre RVE 

  



Po odstránení všetkých nedostatkov, sa objaví v Run LVS správa o úspešnej 

kontrole ako je to na obr. 

 

 

 

 

 

 

 

 

 

 

LVS Report File  



Run PEX 

Slúži na zistenie parazitný prejavov, v hornej lište Calibre → Run PEX- okno 

Calibre Interactive – Pex. Dôležité je nastaviť Inputs v sekcii Netlist. 

Formát- SPICE a odškrtneme Export from schematic viewer (obr.). 

Cestu zadáme ako pri Run DRC či Run LVS, napr.: 

/home/Priezvisko/ams_circuits.proj/BP.lib/default.group/logic.views/zadanie/v

pt_s35d4_device_ams/zadanie.calibre 

 

 

 

 

Inputs Calibre 

Interactive– PEX  



V ďalšom kroku nastavíme Outputs, formát zvolíme typu ELDO a v položke 

File dopíšeme za text .calibre, výsledok nastavenia je vidieť na obr. 

Potom spustíme Run PEX. 

Spúšťanie Calibre Interactive - PEX 



Po spustení Run PEX sa nám vygeneruje PEX Netlist File. 

PROBLÉM: tento súbor používa dva príkazy, ktorých adresa nie je 

kompletná: .include "zadanie.pex.netlist.calibre.pex" 

.include "zadanie.pex.netlist.calibre.ZADANIE.pxi" 

napr.:/home/ams_circuits.proj/Priezv.lib/default.group/layout.views/zadanie/z

adanie.cal/ 

Jeden z príkazov je znázornený 

na obr., druhý sa nachádza na 

konci Netlistu. 

Je potrebné ich adresu 

doplniť- 2x! 

PEX Netlist File + doplnená 

adresa  



Calibre 2 Eldo 

V prostredí, kde sme vytvorili Layout, v hornej lište zvolíme 

HIT-Kit Utilities→Calibre 2 Eldo. V okne (obr.) zadame cestu 

vygenerovaného netlistu, do ktorého sme za text dopisovali .calibre. 

Cesta Calibre Netlist je napr.: 

$Priezvisko/default.group/layout.views/zadanie/zadanie.cal/zadanie.pex.netlist.calibr

e 

Cesta pre Eldo Netlist je tá istá, plus na konci sa dopíše .eldo, napr.: 

$Priezvisko/default.group/layout.views/zadanie/zadanie.cal/zadanie.pex.netlist.calibr

e.eldo 

 

 

Calibre 2 ELDO 



Import vytvoreného prvku- vytvorenie symbolu 

Vytvorenie symbolu pre náš navrhnutý obvod. 

Musíme ho najprv importovať. 

V ICstudiu (obr.) vyberieme File →Import→ Spice. 

 

 

 

 

 

 

 

ICStudio 

  



V okne Import Spice zvolíme cestu kde sa ELDO súbor nachádza napr.: 

/home/ams_circuits.proj/Priezv.lib/default.group/layout.views/zadanie/zad

anie.cal/zadanie.pex.netlist.calibre.eldo 

V položke One sub-circuit vyberieme názov bunky, napr.: ZADANIE. 

Potvrdíme Import, ak sa zobrazí ďalšie okno, vyberieme Creat Symbol. 

 

 

 

 

 

 

 

Import Spice  



 

V okne View sa vytvorí ikona - symbol násho navrhnutého 

obvodu (obr. vľavo)- aj s parazitnými prvkami. Pre porovnanie na obr. vpravo 

je Layout toho istého obvodu. 

Navrhnutý obvod po vytvorení symbolu- aj s parazitnými prvkami 

 

 

 

 

 

 

 

Layout navrhnutého obvodu 


